
 

 

 
 

Model: PTTC4U 
Multifunction Turntable With MP3 Recording, USB-to-PC, Cassette Playback 

 

 

 

 

 



 

 

 

Read instructions carefully before use and store in a safe 

place for future reference. 
IMPORTANT SAFETY INSTRUCTIONS 

 

When using electrical products, basic precautions should always be followed. Please refer below:   

1. Read Instructions - All safety and operating instructions should be read before operated.    

2. Retain Instructions - Safety and operating instructions should be retained for future reference.   

3. Follow Warnings - All warnings on the product and in the manual should be adhered to.   

4. Follow Instructions - All operating and user instructions should be followed.   

5. Cleaning - Unplug this product from the wall outlet before cleaning. Do not use liquid or 

aerosol cleaners instead use a damp cloth for cleaning.   

6. Attachments - Do not use attachments not recommended by the product manufacturer as they 

may cause hazards.   

7. Water and Moisture - Avoid exposing the product to water and moisture.   

8. Accessories - Securely place this unit before use. The product may fall if not properly placed 

causing serious injury to a child or adult and may damage the product. Use only with a stand, 

bracket, or table recommended by the manufacturer. If the product needs to be mounted, you 

should follow the manufacturer's instructions and should use a mounting accessory recommended 

by them.   

9. Transporting - This product should be moved with care to avoid 

damage or injury.    

10. Ventilation - Slots and openings in the cabinet are provided for 

ventilation.  This is to ensure reliable operation of the product and to 

protect it from overheating. Openings must not be blocked or covered. 

This product should not be placed in a built-in installation such as a 

bookcase or rack unless proper ventilation is provided or the 

manufacturer's instructions have been adhered to.         

11. Power Sources - This product should be operated only from the 

type of power source indicated on the marking label. If you are not sure of the type of power 

supply to your home, consult your product dealer or local power company. For products intended 

to operate from battery power, or other sources, refer to the instruction manual.   

12. Power-Cord Protection - Power-supply cords should be properly secured so that they are not 

likely to be entangled in any way.   

13. Lightning - For added protection for this product during a lightning storm, or when it is left 

unattended for long periods of time, unplug it from the wall outlet and disconnect the antenna or 

cable system. This will prevent damage to the product due to lightning and power-line surges.   

14. Overloading - Do not overload wall outlets and extension cords, as this can result in a risk of 

fire or electric shock.  

15. Object and Liquid Entry - Never push objects of any kind into this product through openings 

as they may touch dangerous voltage points or short-out parts that could result in a fire or electric 

shock.  



 

 

16. Servicing - Do not attempt to repair this product yourself as opening or removing covers may 

expose you to dangerous voltage or other hazards. Refer all servicing to qualified service 

personnel.   

17. Damage Requiring Service - Unplug this product from the wall outlet and refer servicing to 

qualified service personnel under the following conditions:   

a. If the power-supply cord or plug is damaged.   

b. If liquid or objects have fallen into the product.   

c. If the product has been exposed to rain or water.   

d. If the product does not operate and you have followed the manual for troubleshooting.   

e. If the product has been dropped or damaged in any way, and the product exhibits a distinct 

change in performance.    

18. Replacement Parts - If a part needs to be replaced, be sure the service technician has used 

replacement parts specified by the manufacturer or have the same characteristics as the original 

part. Unauthorized substitutions may result in fire, electric shock, or other hazards.   

19. Safety Check - Upon completion of any service or repairs to this product, ask the service 

technician to perform safety checks to determine that the product is in proper operating condition.   

20. Wall or Ceiling Mounting - The product should be mounted to a wall or ceiling only as 

recommended by the manufacturer.   

21. Heat - The product should be situated away from heat sources such as radiators, heat registers, 

stoves or other products (including amplifiers) that produce heat.    

  

PRECAUTIONS   

 

1. In order to shut off the unit completely, unplug the power cord from the wall outlet. Be sure to 

unplug the unit if you do not intend to use it for a long period of time.    

2. Incorrect use of controls, adjustments and performance other than those specified herein may 

result in hazardous radiation exposure.   

3. Should this product malfunction, discontinue use and contact a qualified service center.   

   

WARNING 

To reduce the risk of fire or electric shock, do not expose this appliance to rain or moisture. 

CAUTION 

RISK OF ELECTRIC SHOCK- DO NOT OPEN! 

To reduce the risk of electric shock, do not remove casing. 

No user serviceable parts inside. Refer servicing to qualified service personnel. 

The light flash with arrowhead symbol, within an equilateral triangle, is intended to 

alert Users to the presence of “dangerous voltage” which may be of sufficient 

magnitude to cause electric shock to persons. 

 

The exclamation point inside an equilateral triangle is intended to alert Users to the 

presence of important operating and maintenance (servicing) instructions in the 

literature that may accompany the appliance. 

 

 



 

 

 

BEFORE USE 

 

1. Choose a safe location and avoid placing the unit in direct sunlight or near any heat source.     

2. Avoid locations subject to vibrations, excessive dust, cold or moisture.     

3. Do not open the unit as this may result in electrical shock. If a foreign object is inserted 

accidentally contact your dealer.  

4. When removing the power plug from the wall outlet, pull directly on the plug, NOT the cord.     

5. Do not attempt to clean the unit with chemical solvents as this might damage the finishing. A 

clean, dry cloth is recommended for cleaning.     

6. In order to completely turn off the unit, unplug the power cord from the wall outlet. 

 

TURNTABLE PARTS 

1. Dust cover 

2. 45 rpm adapter  

3. Lift lever 

4. Tone Arm rest 

5. Speed Selection 

6. Auto Stop Control 

7. Tone Arm 

8. Platter/Turntable 

9. Stylus(Needle)Cartridge 

10. Cassette Slot 

11. Aux in 

12. Rotary Volume Control with Power 

ON/OFF function 

13. Built in Speaker in the 2 sides 

14. USB Jack 

15. RCA output/Aux output 

16. AC power cord 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

IMPORTANT INFORMATION FOR AUDIO PLAYBACK & RECORDING 

To playback/record audio via the turntable function, ensure that the cassette tape chamber is empty 

(fully ejected). To playback/record audio via the cassette tape function, ensure that the turntable’s 

tone arm is positioned on the Tone Arm Rest. This unit does not support simultaneous 

playback/recording from both audio sources. 

 

LISTENING to a RECORD 

1. Raise the dust cover.  

2. Connect the AC power cord to an electrical outlet (230V~50Hz). 

3. Use a RCA cable to connect the unit’s RCA output with your powered speakers or amplifier.  

Make sure the red and white RCA cables are inserted in the red and white jacks accordingly.   

4. Place a record on the turntable and select the player speed (33/45/78) according to the desired 

record speed. NOTE: when playing a 45 rpm record, use the 45 rpm adapter. 

5. Remove the tone arm from the rest, push the Lift Lever backward to raise the tone arm and 

gently move the tone arm to the desired position over the record. The turntable will begin to 

spin when the arm is moved toward the record. Push the Lift Lever forward to lower the tone 

arm slowly onto the desired position on the record to begin playing the record. 

6. If Auto Stop Control is turned ON, record will stop automatically when finished.  

If Auto Stop Control is turned OFF, record will NOT stop automatically when finished.   

7. For best performance and product maintenance, unplug the turntable when not in use. 

 

LISTENING to a CASSETTE: 

1. Insert the cassette into the cassette slot. The tape will commence play automatically. 

2. Adjust the volume control to your desired sound level. 

3. If the handspike is pushed in half way, the tape can be fast-forwarded. To stop, push the 

handspike slightly and the cassette will resume playing. If the handspike is pushed to the 

bottom, the tape will be ejected. 

4. The tape will stop automatically when it comes to its end. 

5. A tape can only be rewound by turning it over and using the player’s fast-forward feature as 

described above. 

 

CONNECTION to an EXTERNAL DEVICE: 

1. Connect the external sound source through the RCA jacks. 

2. Adjust the volume control to your desired sound level. 

 

TURNTABLE STYLUS (needle) REPLACEMENT     

To replace the turntable stylus (needle), please refer to the instructions below: 

     

Removing the stylus from the cartridge    

1.  Place a screwdriver at the tip of the stylus and push downward as shown in 

direction “A”. 

2.  Remove the stylus by pulling the stylus forward and pushing downward. 

  



 

 

Installing the stylus (needle)    

1.  Hold the tip of the stylus and insert the stylus by pressing as shown in direction “B”. 

2.  Push the stylus upward as in direction "C" until the stylus locks into the tip position.    

 

 

RECORD YOUR VINYL / TAPE to a WINDOWS PC 
 

SOFTWARE INTRODUCTION  

  

Audacity application software is included with this product and is designed to record and save 

music from the unit to a computer. The software then allows for the same recorded files to be 

converted and edited to .WAV and/or .MP3 file formats. The recorded music can then be played 

using Windows Media Player and other applications that support .WAV and .MP3 formats.  

 

For complete instructions on how to setup and use Audacity please refer to: 

http://audacity.sourceforge.net/help/documentation 

  

SOFTWARE INSTALLATION and USB CONNECTION    

  

To install the Audacity software in your computer, please follow the instructions below.   

 

1. Insert the Audacity software (included) into your computer's disc tray.  

 

The Audacity Setup Wizard will appear. Click on "Next" to install the software. 

 



 

 

 

2. Select “I accept the agreement” and click on Next. 

 
 

3. Continue to click on the "Next" button until the software installation begins. 

 



 

 

  

 
 

 

 

 

 

 



 

 

4. Click on the "Install" button to start the Audacity software installation.  

 

 
 

 

 

 

 



 

 

5. Click on "Finish" to complete installation. 

 
 

 

6. You can now open the Audacity software and start recording your files. 

 

 

 



 

 

RECORDING OPERATION STEPS (VINYL TO WINDOWS PC) 

 

1.  Connect the USB cable to your turntable and your computer. No extra driver is required and 

your computer should automatically detect the turntable. 

 

2.  Power on your turntable and play your record by lifting the tone arm towards the platter.  

 

3.  Double click the Audacity program and you will see this interface screen on your computer.  

 

 

4. Adjust the output and input volume. 

 

5.  Select the RECORD button  to start recording.   



 

 

 

6.  Select the PAUSE  button to pause the recording.   

7.  Select the STOP  button to stop the recording.   

8.  Select the   to skip to the start. 

9.  Select the  button to go to the end. 

 

10. You can see the recorded file on your computer and convert the recorded file to other formats 

including .WAV and .MP3. 



 

 

 

 

11. Put the saved file in the Audacity program and press the PLAY  button to play the 

file.  

 

CONVERTING RECORDED FILES to .WAV and .MP3 FILE FORMATS  

 

Please make sure that you have properly connected the unit to your computer and follow the 

instructions below to convert your files to “.wav and .mp3” file formats. 

  

1. Make sure that the Audacity installation disc is still inserted in your computer. Go to your 

Desktop and double click on the "My Computer" icon.   

 

2. Locate the CD ROM Drive and double click on the icon.   

 

3. Copy the lame_enc.dll file and paste it to your Desktop. 



 

 

 

 

4. After copying the file, open the Audacity Software. Click on the "RECORD" Button to start the 

recording process. Make sure that a vinyl record is playing on the turntable and the USB cable is 

connected to the turntable and your computer.   

 

5. You may press the Stop Button at any desired time. Once you have the recorded file that will be 

converted, press the "Edit" tab and select "Preferences". 

 
6. Locate "File Format" tab and click on the "Find Library" button. 



 

 

 

 

 

7. Click the "Yes" button, then go to your Desktop and highlight the lame_enc.dll.  

Next, click on the "Open" button.  

 



 

 

 
 

8. Click on the "OK" button and return to the default window of the Audacity Software. 

 



 

 

 

9. Click on the "File" tab and the option will be given to export the recorded file as “.wav”, 

“.mp3” or “.ogg” file formats. 

 

10. Once you have selected the desired file format to export your recorded music, enter the file 

name and location where you want to save the file on your computer. Once finished, click on the 

"Save" button. 

  

 

11. Enter the title, artist and any other information about the MP3 file that you have created and 

click on the "OK" button.   

 



 

 

12. Next, go to the location of the file you have converted. You can play the converted file on any 

application that supports .WAV or .MP3 formats. 

 

NOTE: Converted files can be transferred (burned) to a CD.  Please refer to the manufacturer's 

instructions provided with your CD burner or computer for additional details. 

 

 

RECORDING OPERATION STEPS (CASSETTE TO WINDOWS PC) 

 

1. Connect your machine to your PC with the USB cord. 

 

2. Place the tone arm at its resting position and insert a cassette tape to commence play. 

 

3. Start AUDACITY, and refer to the steps 4 onwards as described under RECORDING 

OPERATION STEPS (VINYL TO WINDOWS PC). 

 

 

RECORD YOUR VINYL / TAPE to a MAC PC 

1. Plug your unit into a power outlet.  

 

2. Connect your unit to your MAC using the supplied USB cable. 

 

3. Press the power button on your unit. 



 

 

 

4. Open “System Preferences” on your MAC:  Applications > System Preferences. 

 

5. Under ‘Hardware’ click on ‘Sound’ (icon of speaker). 

 

6. Select ‘Input’ and choose the AK5371 USB device (may also appear as USB PnP device). 

 
 

7. Close the System Preferences window. 

 

8. Ensure the Audacity Software has been installed to your computer. (Note: the latest version of 

Audacity can be downloaded here: http://audacity.sourceforge.net/download/mac) 

 

7. Launch the Audacity Software from the saved location (commonly saved under 

‘Applications’) 

10. Open Preferences for the Audacity Software under the Audacity Menu. 



 

 

 
 

11. Refer to the ‘Audio I/O tab’ and under ‘Recording’ select AK5371 (may also appear as USB 

PnP device) and press ‘OK’. 

 

12. Press the RECORD button in the Audacity Software (NOTE: recordings will begin as soon as 

you release the RECORDING button). Position the needle on your vinyl record, or commence 

cassette tape playback where you would like the recording to begin. 

 

 

 

 

 

 

 



 

 

13. Press the STOP button when you would like the recording to end. 

 

14. You can edit your recorded track(s) using Audacity. 

 

15. You can save your recordings to various file formats by making changes under the File Menu. 

 

TIPS for BETTER TURNTABLE PERFORMANCE 

 

1. When opening or closing the turntable cover, handle it gently, moving it either at the 

center or equally from both sides. 

2. Do not touch the stylus (needle) tip with your fingers; avoid bumping the stylus on the 

turntable or record’s edge. 

3. Clean the stylus tip frequently - use a soft brush in a ‘back-to-front’ motion only. If 

cleaning does not resolve sound quality issues when playing back your records, you may 

need to replace the turntable’s stylus (about every 250 hours). 

4. If you must use a stylus cleaning fluid, use very sparingly. 

5. Wipe the dust cover and turntable housing gently with a soft cloth. Use only a small 

amount of mild detergent solution to clean the turntable and dust cover. 

6. Never apply harsh chemicals or solvents to any part of the turntable system.  

7. Always unplug the unit from its AC outlet, secure the tone arm and replace the protective 

cap on the stylus before moving.  

8. Clean your records with an anti-static cloth to maintain sound quality. 

 

PYLE MISCELLANEOUS PARTS MISC ACCESSORIES

http://www.carid.com/pyle/
http://www.carid.com/miscellaneous/

